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Getting Started 
 

This booklet describes how content developers 
can use Saba Centra Recording Studio to create 
and edit content and Saba Centra 7 Agenda 
Builder™ to create, edit, and save Agendas for 
Saba Centra 7 Symposium and Conference 
events. 

Launching Recording Studio 
You can launch the Recording Studio in several 
ways. Depending on how you launch the 
Recording Studio, it opens in the Studio Timeline 
Editor (STE) or Studio Recorder (SR) mode. 

You can launch the Recording Studio in the STE 
mode: 

� By choosing to edit an existing recording in 
Centra (Manage Events > Manager 

Recordings > Edit). 

� By double-clicking the native Recording 
Studio CCRZ file. The Recording Studio client 
must be already installed on the machine. The 
client is installed when you first launch the 
Recording Studio from Centra. 

You can launch the Recording Studio in the SR 
mode: 

� By choosing to create a new recording in 
Centra (Content Manager > Create 

Recording). 

� By double-clicking the Recording Studio 

shortcut on the Desktop. The shortcut is 
created when you launch the Recording 
Studio from Centra for the first time and 
download the Recording Studio client. 

� By selecting the Recording Studio option 
from the Start menu. An entry for the 
Recording Studio is added to the Start menu 
when you first launch the Recording Studio 
from Centra and install the Recording Studio 
client on the machine. 

Creating Recordings 
1. Prepare for the recording by performing the 

following optional tasks: 

� Import an agenda for the recording by 
clicking the Import button and selecting a 
.saz agenda file. 

� Import content, including PowerPoint 
slides, by clicking the Import button. 

� Create Whiteboard content by clicking the 
Whiteboard button. 

� Use application share to demonstrate 
software and coach users during the 
recording by clicking the Appshare button. 

2. Start recording by clicking the Record button. 

� To record voice, hold down the Talk 
button. To talk hands free, lock down the 
talk button using the Lock button. 

� Switch to full-screen mode during the 
recording by clicking the Full Screen 
button. 

� Use the sliding scale to adjust the audio 
volume for the headset and microphone. 

3. Save the recording: 

� Switch to the Studio Timeline Editor (STE) 
by clicking the Editor button in the Studio 
Recorder. 

� Save the recording in the Centra format 
(.ccrz) or export it to the WMV or WAV file 
format. 
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Editing Recordings 
In the Recording Studio you can open and edit 
recordings in the CCRZ, CCRF, and EXE file 
formats. 
When editing a recording, you can:  

� Add content using the Import button. 
� Delete content by selecting the content area 

in the timeline and clicking the Delete 
button. 

� Replace audio by selecting the area in the 
timeline and clicking the Record Audio 
button. 

� Combine (copy and paste) Centra 
recordings by opening compatible (version 
7.5 or later) recordings and copying and 
pasting the selections in the Timeline 
Editor. 

� Add, remove, or rename index points by 
using the corresponding buttons in the 
Timeline Editor. 

� Cut, copy, and paste from the Timeline 
Editor. 

When done, save the final version as a Centra 
recording (.ccrz) or produce a WMV or WAV file. 
You can also publish the recording to CMS, or 
Saba Knowledge base if one has been defined in 
your Centra server. 

Saving Recordings 
You can save a recording in the Centra format 
(.ccrz), or export a recording to the WMV or WAV 
file format. Recordings saved in the Centra format 
can be published, played, and edited in Centra. 
Recordings exported to WMV or WAV format can 
be played in a third-party media player. In 
addition, you can choose to create an offline 
playback of the recording (specified in the 
recording properties) when publishing the 
recording to the CMS. 

Saving Recordings in Transportable 
Recording Studio Format 
You can use one of the following methods to save 
a recording in the Centra file format: 

� From the File menu select Save. For a new 
recording, you will be prompted for a 
name and location for the CCRZ file. For 
an existing recording, the original CCRZ 
file will be overwritten; or 

� From the File menu select Save As. You 
will be prompted to enter a name and 
location for the new CCRZ file. 

Saving Recordings in WMV or WAV File 
Format 
To save a recording in the WMV or WAV format: 
1. From the File menu, select Export. 
2. Select WMV or WAV from the save as type 

drop-down list. 
3. Specify the location and filename for the 

recording. 
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Studio Recorder Interface 

 Recording 

Click the button to start recording. The recording 
indicator appears on the bottom of the screen as 
time begins to increment. 

 Switching to Editor 
Click the button to switch to the Studio Timeline 
Editor. 

 Importing Agenda 

Click the button to import a Centra agenda file 
(.saz). 

 Sharing Applications 

Click the button or press the F7 key to share 
applications or files on your computer. 

 Sharing Web Safari 
Click the button or press the F9 key to share the 
web browser screen in the recording. 

 Importing Whiteboard Content 
Click the button or press the F10 key to import 
Whiteboard content. 

 Configuring Audio 

Click the button or press the F6 key to select your 
hardware audio type and adjust audio volume. 

 Enabling Video 
Click the button to enable video. A video camera 
must be connected and configured. 

 Full-Screen Mode 

Click the button or press the F11 key to enable a 
full-screen mode. 

 Recording Voice 

Press the button, the CTRL, or F12 keys to record 
voice. To talk hands-free, click the Lock button or 
use the Ctrl + T keys. 

 Muting Audio 

Click the icons to mute audio during an event. 

 Adjusting Audio 
Use the sliding bar to adjust the audio during an 
event. 

 Importing Content 

Use the button to import content such as PPT 
presentations, agenda, charts and images. 
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Studio Timeline Editor Interface 

 Creating a New Recording 

Click the button to create a new recording file. 

 Opening an Existing Recording 

Click the button to open an exiting recording. 

 Saving a Recording 

Click the Save button to save the recording. 

 Cutting 

Click the Cut button to cut the selection from the 
timeline. You can paste the selection to a different 
position in the same or a compatible recording. 

 Copying 

Click the Copy button to copy the selection in the 
timeline to the clipboard. 

 Pasting 

Click the button to paste the contents of the 
clipboard to the current position in the timeline. 

 Deleting 

Click the button to permanently delete a selection 
from the timeline. 

 Creating an Index Point 

Click the button to create a new index point at the 
current position in the timeline.  

 Delete Index Point 
Click the button to delete index points within the 
selection in the timeline. 

 Renaming an Index Point 
Click the button to rename an exiting index point. 

 Inserting Time 

Click the button to insert a specified amount of 
time of dead space at the current position in the 
recording. 

 Recording 

Click the button to record new material. The 
recording is inserted at the current position in the 
timeline or will replace the current selection. 

 Recording Audio 

Click the button to record new audio starting at 
the current position in the timeline. 

 Navigating to Previous Index Point 

Click the button to jump to the previous index 
point in the recording. 

 Navigating to Next Index Point 

Click the Next button to jump to the next index 
point in the recording. 

 Fast Reverse 

Press the button to fast reverse the recording to 
the designed position. 

 Fast Forward 

Press the button to fast forward the recording to 
the designed position. 

Pausing 

Press the button to pause the recording playback. 

 Playing 

Press the button to preview the recording. 

 Undo 

Use the button to revert the recording to the last 
state prior to the last editing action. 

 Redo 
Use the button to revert the recording back to its 
edited state prior to executing the undo 
operation. 

 Switching to Full View 
Click the button to expand the recording interface 
to full screen size. 

 Switching to Normal View 

Click the button to switch the recording interface 
back to the original screen size. 

 Zooming In and Out 

Use the buttons to adjust the current zoom level 
on the timeline scale. 
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Opening Agenda Builder 
1. Log into the Saba Centra server by entering a 

username and password. The My Schedule 
page (home page) appears. 

2. Click Agenda Builder on the left side of the 
page. (This step requires appropriate 
privileges). Agenda Builder opens. The first 
time the link is clicked, Agenda Builder 
downloads to the computer. 

Inserting Files into an Agenda 
3. Select Insert, File from the Agenda Builder 

menu bar. The Select a File dialog box 
appears. 

4. Select a file to insert. If necessary, change 
directories to locate the file. 

Only supported file types appear in the Select 
a File dialog box. To add other file types, 
replace the File name field with *.* 

5. Click Open. 

6. For PowerPoint presentations, the Image 
Format dialog box appears. Select GIF for 
slides with text and simple graphics.  Select 
JPG for slides with graduated color or 
photographs. Select HTML to preserve 
PowerPoint animation and media file 
properties. 

7. For all file types other than PowerPoint, the 
Edit Item Properties box appears. All files can 
be imported using the default property 
settings.  To import files using the default 
settings, click OK. 

8. Click to deselect Available out of session if 
the resource should be available only to 
Participants during an in-session Event. This 
feature is selected by default. 

9. Select Contains Audio to disable microphones 
while the resource is viewed. Do not select 
Contains Audio unless the item contains 
audio. 

10. Select Use System Browser to launch the 
resource in a separate browser window rather 
than in the media window. 

11. Click OK after making a selection. 

Inserting an Evaluation 
1. Choose an insertion point. 

2. Select Insert, Evaluation.  The Edit Item 
Properties dialog box opens. 

3. Enter a Title in the Title text box. 

4. Select a Recording results option. The record 
options save participant responses that can be 
tracked and reported. 

5. Select one of the grade options to correct 
participant responses. Select the Do not grade 
option when collecting feedback. Note: The 
grade options are for Symposium only. 

6. Click OK. The Evaluation title appears in the 
Agenda hierarchy and the Evaluation editor 
opens. 

7. Enter Multiple Choice, Fill in the Blank, or 
Long Answer questions. 

� Add an underscore (“_”) to a Fill in the 
Blank question to specify a blank. The 
underscore is replaced with a text box 
(only one per question). 

� Long Answer questions are available only 
for recorded evaluations. 

� Correct answers are available only for 
graded evaluations (Fill-in-the-blank and 
multiple-choice questions). 

� Drag and drop a question to modify the 
question sequence. 
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Inserting a Survey 
1. Choose an insertion point. 

2. Select Insert, Survey.  The Edit Item 
Properties dialog box opens. 

3. Enter a Title in the Title text box. 

4. Enter a unique Survey Question in the 
Question text box. (You cannot have two 
identical survey questions in one Agenda.) 

5. Enter up to 12 Answers in the Answer text 
boxes.  Provide at least one answer. 

6. Click OK. The Survey title appears in the 
Agenda hierarchy. 

Inserting a Tool Placeholder 
1. Choose an insertion point. 

2. Select the Insert menu. 

3. Select Appshare, Whiteboard, or Web Safari. 
Agenda Builder creates an Agenda item for 
the tool that you select. When the Leader 
clicks the Agenda item during an Event, the 
tool launches. 

Inserting Content from the Content 
Catalog or Knowledge Center 
1. Choose an insertion point. 

2. Select Insert, Knowledge Resource or Insert, 

Content from Catalog.  The search dialog box 
appears. 

3. In the Search By drop-down menu, select 
either Title or Keyword. 

4. In the Search For field, type as much of the 
Title or Keyword that you know.  You can also 
leave this area blank to return a list of all 
available resources. 

5. Select the type of content to import in the 
Type drop-down menu. 

6. Click Search. Agenda Builder lists the search 
results. 

7. In the list of search results, click on the desired 
content. 

8. Click Insert. The Edit Item Properties dialog 
opens. 

9. Type a name in the Title field. 

10. Click to deselect Available out of session if 
the resource should be available only to 
Participants during an in-session Event. This 
feature is selected by default. 

11. Select Contains Audio to disable microphones 
while the resource is viewed. Unless the item 
contains audio, do not select Contains Audio. 

12. Select Use System Browser to launch the 
resource in separate browser window, instead 
of the media window. 

13. Click OK. The content is inserted into the 
Agenda. 

Using the Nesting Allowed Feature 
Build a hierarchy by designating an Agenda item 
as a folder using the Nesting allowed feature and 
placing other Agenda 
items inside. For 
instance, convert a 
slide introducing a 
module into a folder. 

Use the following 
instructions to nest 
Agenda items: 

1. Right click the Agenda item to designate as a 
folder. 

2. Select Edit, Nesting allowed. 

The icon changes to a folder in the Agenda 
hierarchy. The item display in the Media 
Window is unchanged. 

3. Move Agenda items into the folder. 

Copying and Pasting Agenda Items 
Copy and paste an Agenda item or folder to 
create a duplicate item in the Agenda item 
hierarchy. Copying a folder creates a duplicate of 
the folder and all Agenda items in the folder. 

Use the following instructions to copy and paste 
an Agenda item: 

1. Click the Agenda item. The item name is 
highlighted. 

� Select multiple adjacent items by pressing 
and holding the Shift key while clicking on 
the last item. 
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� Select multiple non-adjacent items by 
pressing and holding the Ctrl key while 
clicking on the other items. 

2. Select Edit, Copy. 

3. Select the Agenda item directly above the 
destination of the copied item (or the open 
folder where the item is to be copied). 

4. Select Edit, Paste. 

Dragging and Dropping Agenda Items 
1. Click the Agenda item. 

The item name is highlighted. 

2. Click and drag the Agenda item to the new 
location. 

An arrow icon confirms the selected item’s 
movement. A line appears below each Agenda 
item as the selected item is dragged. 

3. Release the mouse button to insert the item in 
the new location. 

Saving an Agenda 
Save the Agenda to a local drive and upload it to 
the Saba Centra server. 

1. Choose File, Save or Save As (to save the 
Agenda under a new name). The Save as 
dialog box opens. 

2. If necessary, select the folder to save the 
Agenda. 

3. Type an Agenda name. 

4. Click Save. 

The file extension for an Agenda is .saz 
(Symposium Agenda Zipped). 

Saba Centra 7 Agenda Builder Tips 
The following tips can help you use Agenda 
Builder: 

� An Agenda name can contain up to 255 
alphanumeric characters, including spaces. 

� Do not use any of the following characters in 
names of Agendas: 
 \ / : * ? " < > # | % _ ; ! @ $ & 

� Insert files with the following file extensions: 
.txt, .html, .htm, .bmp, .gif, .jpg, 
.png,.jpeg, .avi, .mov, .qt, .mpg, .mp2, 
.wav, .au, .rpm, .ram, .ra, .rm, .asf, 
.ppt, .rmf, .asx, .wmv. 

� Users must have Microsoft PowerPoint 2000 
SR2, XP, or 2003 installed to import a 
PowerPoint file into an Agenda. 

� Choose the Client Side download option for 
files greater than 50 KB in size, and audio and 
video files. 

� Open two Agenda Builder windows, and copy 
Agenda items from one Agenda and paste into 
the other.  

� After downloading Agenda Builder from the 
Saba Centra server, you do not have to log in 
to the server to create an Agenda. 

� To add unlisted file types, replace the File 
name field with *.* 
Participants must have the application on 
their computers to view the file. 

Where to Get More Information 
For information about Saba Centra training, 
Documentation, and Knowledge objects, please 
see Getting Information about Saba Centra 7. 

 

 

 

 


